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1. Introduction
The Clipboard App is a Sabre developed Red App that enables Travel Consultants with
efficient way to convert cryptic GDS responses into Traveller friendly, fully decoded
and easy to share HTML document. It supports branding, translations and
customization of the output it generates.
Clipboard App has four main functions:
•
•
•
•

Itinerary
Schedules
Shopping for Air, Hotel and Car
Hotel Billback Fax

Except for the Hotel Billback function, Clipboard App output is stored in the Operating
System clipboard(memory), from where it may be “pasted” into email clients like
Microsoft Outlook, word processors like Microsoft Word and other applications
capable of rendering HTML content like Microsoft Excel.
For Hotel Billbacks, the booking information is formatted and automatically placed in a
PDF document.
Note: Hotel billback is a process where an agent books a hotel, then requests that
charges get billed back to the travel agency on completion of the travellers stay.
Typically, this requires the agent to fax document with a credit card number to
guarantee that they will accept the charges.

1.1. To launch Clipboard, you have three options:
1)

Sabre Red 360 Menu Bar - Tools > Clipboard

2)
Sabre Red 360 - Application Side Bar Launcher >
Clipboard
Once you select either of the above options, you will be
presented with the Clipboard Function Menu.
Note: Within the Clipboard Menu you also have direct
access to the Clipboard User Guide, just click on the
Question Mark Icon at the top right-hand corner.
3)
The 3rd option you can use to access Clipboard is
the Active Listening feature. (Active Listening is a Sabre
functionality that allows Clipboard to be launched
automatically based on the end-user input into the
emulator.)
There are various active listening commands that can be
entered into the emulator to display the different function window within Clipboard.
Below is the list of commands with the corresponding window they will launch:
<CB> will launch the Clipboard Function Menu
<CB ITIN > Itinerary window
<CB SCHED> Schedule window
<CB SHOP¥AIR> the Air Shopping window
<CB SHOP¥CAR> Car Shopping window
<CB SHOP¥HOT> Hotel Shopping window
<CB BILLB> Hotel Billback window

2. Setup
2.1. Software Prerequisites
The Clipboard application works in conjunction with Sabre Red 360.
2.2. Accessing the Clipboard Application
The Clipboard application is made available via the Sabre Red 360 Agency Admin Tool.
To deploy the application to users, the Agency Administrator should access the Agency
Admin Tool via the Sabre Red 360 and deploy the application to the applicable users.
Full details on the exact process for this can be found in the Agency Administration Tool
reference material which is available from Sabre Central.

2.3. Clipboard Settings
Within the Clipboard Settings you can control and predefine what information you would
like to see on the output.

The Clipboard Settings can be found within the Sabre Red 360 on the Menu Bar under
Tools > Options > Red Apps Settings > Clipboard Settings.

2.3.1. Agent Preference Configuration
**IMPORTANT **
•
•

Users can only manage a configuration in a level to which they have
managerial privileges (that has the CREATE keyword in the host).
Authorized users can restrict a property definition privilege from next
level users

•

To manage Agency or Branch level configuration the agency need to set
the path of the configuration file in the
CLIPBOARD Agency Information Setting Page.

To ease the configuration of the app during installation and to avoid user
mistakes, we suggest the following centralized approach:
•

Agency Configuration files are maintained on a central server / Shared
folder

•

Shared folder location is defined when the app is installed and will be
located on an agency sever.

•

There are four levels of configurations matching Sabre agency levels:
o System (Sabre) – Provided default configuration as part of the
Clipboard plugin bundle
o Agency (SC)
o Branch (PCC)
o Agent (PCC EPR)

•

The admin will select the relevant preference and click on the export path. This
action needs to be completed once off and needs to be completed on the
computer that will have the shared folder location.
1. Open Windows Explorer
2. Navigate to the desired shared folder location
3. In the white space right click
4. Select New
5. Select Text Document

6. Name this document AgencyPreference
7. In the white space right click
8. Select New
9. Select Text Document
10. Name this document BranchPreference
11. Change the file type extension to .Pref
a. AgencyPreference.pref
▪

BranchPreference.pref

•

If you can't see the file extension, go to organize > Folder and Search
Options, then click the View Tab. Uncheck the box titled "Hide extensions for
known file types" like so: Click OK.

1. To set the relevant path in the Clipboard Settings options page, select the
Agency Information Link
2. Select the browse button, next to the Agency Level Preference File or the
Branch Level Preference File field
3. Navigate to the desired shared folder location i.e. C:\Sabre\Clipboard

4. Select the desired file AgencyPreference or BranchPreference
5. Click the Open button
6. Click Apply button

7. Click the Export Branch Preferences
8. Click the Export to Agency Preferences
9. Click Ok to close the window

•

After the admin has set the relevant preference send the path to all agents in
order so that they will set it up in their Sabre Red 360 Clipboard settings in the
Agency Information Setting page.

•

The agent can include the file path for their agency logo (Maximum pixel
size 575x575). All this information will be transposed onto each output.

Preference value resolution:
•
•
•
•
•

Property value is initialized according to default settings.
If a configuration exists on Sabre level, the default value is set according to it.
If an agency level configuration exists and this property is defined, the default
value is set according to it.
If branch level configuration exists and same properly is defined the default,
value is set according to it.
If an agent level configuration exists and this property is defined, the value is set
according to it, overriding the previous levels preference configuration
Property management:

•
•
•
•

•

Property current value is displayed.
Value editing is enabled only if the user has a managerial role and the property
was not defined as restricted for edit by a higher-level user.
If the property has been edited, the configuration at Agent level is modified.
A user with managerial role will be allowed to export his preferences to be used
as Branch level preferences. If the branch is the main branch of the Agency (SC)
a user with managerial role will be able also to export his preference to be used
as Agency level preference.
Agency Sabre Red 360 of other users is updated with the new value after they
restart it.

•

Values set at Branch & Agency level are used as default on Agent application
start those values cannot override Agent defined preference.

2.3.2. Admin Preference editing Page:
Option to disable a preference
configuration for Agents in same
agency

Option to export
preference to Branch
Level configuration

Once the information has been entered select <Apply> followed by <OK> for the
Agency Information to be updated. The Option to Export to Branch Preferences
will be enable if the user has the applicable rights.
2.3.3. Agent Preference Editing Page:

Field disable for editing
by Agency level
configuration

Field enabled for editing by
Agency level configuration

2.3.4. Agency Level Admin Preference editing Page:

Option to disable a preference
configuration for Agents in same
agency and for Admin users of the
current Agency branches
Option Disabled by higher level
configuration

Option to export preference
to Agency Level configuration

2.3.5. HTML Preference – Colour and Fonts Settings
The output of itineraries, schedules and shopping may all be customised to match
the agency preferences.
At this stage you will be presented with several options.
The first two options determine any Title Bar colour settings, with one option for
background colour and the other for the foreground. By clicking on either box, you
will be presented with several colour options. By changing these colours, the
sample text beneath shows how this will look.
Similarly, the next option will update the colours and fonts for the body of the
output information.
As everything will be presented within a table, the border colour may be specified
on the 3rd option, “Table Borders Colour”. Font type, size and style may also be
amended by selecting the <Change> radio button. Note: Changing the font will
affect the table layout.

Time format option allows you to select the time shown in either 12 or 24-hour
clock on the output.
The Image inclusion method relates to the way the vendor icons (logos) are sent
to your destination canvas. The default is set at Linked, however if you use Virtual
Machine you will need to change this to Embedded, as this will ensure the vendor
logos are in the HTML string.
Output Language option allows you to change the language of the output
response from the default language setting of the App.
Once the information has been entered select <Apply> followed by <OK> for the
Agency Information to be updated. The Option to Export to Branch Preferences
will be enable if the user has the applicable rights.

2.3.6. Schedule Preference Settings
The first checkbox will determine if the output should be in Plain Text. This feature
is useful when your destination canvas, does not accept HTML. This is the case
with such applications as Notepad, or Open Office mail applications. Note: When
selecting plain text for your output you will need to select a fixed width font.
The Format of the HTML output has three options:
a) Styled option provides refreshed look&feel and is easier to read
b) Compact, which is typically used when a traveller is viewing the
schedule response on a Smart Phone device.
c) The Wide option is used for standard emailing or printing.
The above settings are not compatible with the plain text output option.
The next option allows you to choose whether you would like your agencies
details and logo shown on the output.
The Display Results option allows you to view the schedule result in a new tab
within the Sabre Red 360. This is useful if the agent wants to view the airline
schedule rather than emailing the results to the customer.
The output response for Schedules is capped at 100 segments; however, an agent
can specify the number of segments returned, if they would prefer less than the
capped amount. This can be set up in “Maximum number of segments in the
output”. This restriction has been put into place to avoid the application taking an
excessive amount of time to return a response.

Once the information has been entered select <Apply> followed by <OK> for the
Schedule Preference Information to be updated. The Option to Export to Branch
Preferences will be enable if the user has the applicable rights. Note: Airlines logos
are not used to save on space.
2.3.7. Itinerary Preference Settings
The level of detail presented in the itineraries may be adjusted to suit your
customers need.
When selecting Itinerary Preferences, you will be presented with the following
popup window full of options:

The first checkbox will determine if the output should be in Plain Text. This
feature is useful when your destination canvas does not accept HTML. This is
the case with such applications as Notepad, or Open Office mail applications.
Note: When selecting plain text for your output you will need to select a fixed
width font
The Format of the HTML output has three options:
a) Styled option provides refreshed look&feel and is easier to read
b) Compact, which is typically used when a traveller is viewing the
schedule response on a Smart Phone device.
c) The Wide option is used for standard emailing or printing.
The above settings are not compatible with the plain text output option.
The next option allows you to choose whether you would like your agencies
details and logo shown on the output.
The next set of checkboxes will allow you to determine the optional information
for the output. Customers may not wish to see the airline type or the specific
fare class of travel for example.
Because the itineraries can include Fare and Fare Rule information, it is possible
to adjust the way the fare is presented. Some customers may prefer not to see
the total taxes, so the Fare Output checkbox allows the fare amount to be
combined with the tax amount and shown as one total.

Show Price per Person or Total Price will allow you to choose whether you
would like the itinerary fare to show as a per person price or a total price when
there are multiple passengers in the PNR.
Note: If you select Price per Person you cannot combine multiple PQs.
The Mark-up/Service Fee Rounding Up Logic allows to define how result of
calculation of mark-up and service fee is being rounded up.
•

•

•

None – when selected standard decimal rounding logic is applied, e.g.
when calculated mark-up or service fee is $11.1192 it will be rounded up
to $11.12
Next 1 – when selected then result is rounded up to next full number,
e.g. when calculated mark-up or service fee is $11.1192 it will be
rounded up to $12.00
Next 1 – when selected then result is rounded up to next 10, e.g. when
calculated mark-up or service fee is $10,111.1192 it will be rounded up
to $10,120.00

The Mark-up option allows you to include a mark-up for each itinerary and will
be included in the fare amount on the output. Mark-up is hidden in base fare
value. Mark-up can be defined as percent of base fare or as a fixed value e.g.
$10.00
The Service Fee option allows you to include a mark-up for each itinerary which
will be clearly displayed on the output. Service fee can be defined as percent of
Total Price (base fare + mark-up + taxes) or as a fixed value e.g. $100.00
The Tax Breakdown allows you to input a tax code and tax name which will be
displayed in the output. The Name to Show column will be displayed as the label
of the tax amount in the output. If no name is given, the Tax Code will appear.
There is a feature within the Itinerary function that allows you to add the fare
and fare rule information into the Sabre booking as “remarks”. The remaining
input field on the above popup window allows you to include a prefix to these
“remarks” e.g. if a Cross-of-Lorraine is entered these remarks will show on
Tripcase itineraries too. Or, if a period/full stop is entered the remarks will
become an invoice remark so the information may be transmitted to the back
office.
Once the information has been entered select <Apply> followed by <OK> for the
Itinerary Preferences Information to be updated. The Option to Export to
Branch Preferences will be enable if the user has the applicable rights.

2.3.8. Shopping Preference Settings
The Shopping Preference section is for Air, Car and Hotel Shopping.
The first option available is the Plain Text checkbox. This feature is useful when
your destination canvas does not accept HTML.
This is the case with such applications as Notepad or Open Office mail
applications.
Note: When selecting plain text for your output you will need to select a fixed
width font.
The Format of the HTML output has three options:
a) Styled option provides refreshed look and feel and is easier to
read
b) Compact, which is typically used when a traveller is viewing the
schedule response on a Smart Phone device.
c) The Wide option is used for standard emailing or printing.
The above settings are not compatible with the plain text output option.
The next option allows you to choose whether you would like your agencies
details and logo shown on the output.
There is a feature within each of the shopping functions, which allow you to add
the chosen options into the Sabre booking as “remarks”. This input field allows
you to include a prefix to these “remarks” e.g. if a Cross-of-Lorraine is entered
these remarks will show on Tripcase itineraries too. Or, if a period/full stop is
entered the remarks will become an invoice remark so the information may be
transmitted to the back office.
Under Air Shopping you have the option to include a mark-up that will be added
to every air shopping option selected.
The Mark-up/Service Fee Rounding Up Logic allows to define how result of
calculation of mark-up and service fee is being rounded up. Mark-up is hidden in
base fare value. Mark-up can be defined as percent of base fare or as a fixed
value e.g. $10.00

•

•

•

None – when selected standard decimal rounding logic is applied, e.g.
when calculated mark-up or service fee is $11.1192 it will be rounded up
to $11.12
Next 1 – when selected then result is rounded up to next full number,
e.g. when calculated mark-up or service fee is $11.1192 it will be
rounded up to $12.00
Next 1 – when selected then result is rounded up to next 10, e.g. when
calculated mark-up or service fee is $10,111.1192 it will be rounded up
to $10,120.00

Other Fees is a free form box that gives you the option to add any number of
additional fees that apply. Service fee can be named and can be defined as
percent of Total Price (base fare + mark-up + taxes) or as a fixed value e.g.
$100.00.

To remove one or more fee categories simply select the related check-box and
hit the "Remove" button.
The next set of checkboxes allows you to choose which optional information
you would like displayed in your output. Select or deselect any of these options.
The output response for Hotel Shopping is capped at 16 options; however, an
agent can specify the number of options returned, if they would prefer less than
the capped amount.
This can be set up in Maximum number of option in the output.
This restriction has been put into place to avoid the application taking an
excessive amount of time to return a response.
The output response for Hotel Shopping search distance is defaulted at 20 and
distance units of measurement is defaulted to Kilometers; however, an agent
can specify the search distance and select the distance units of measurement to
be returned.
This can be set up in Default search distance and Distance units of
measurement.
This restriction has been put into place to avoid the application taking an
excessive amount of time to return a response.

Once the information has been entered select <Apply> followed by <OK> for the
Shopping Preferences Information to be updated. The Option to Export to Branch
Preferences will be enable if the user has the applicable rights.

2.3.9. Hotel Billback Fax Settings
The Billback setup allows you to add default free text information which will
appear on each output. This is particularly useful if there are country specific legal
declarations that many need to be shown on the output.

Once the information has been entered select <Apply> followed by <OK> for the
Hotel Billback Setup Information to be updated. The Option to Export to Branch
Preferences will be enable if the user has the applicable rights.
3. Documentation
3.1. Itinerary
3.1.1. Description
Although it is entitled “Itinerary”, this function allows the agent to share an option
of a potential and existing booking information with the customer.
This feature takes the itinerary contents and translates them into a plain language.
Any travel industry codes such as airports or aircraft type are put in to a nicely
tabled HTML output which fits into any space where it is pasted.
Many features are optional, so the agent may choose to add airfares, fare rules or
other details such as taxes and mark-up amounts and itinerary remarks.
Alternatively, these features may be switched off, such as using Plain Text formats
instead of HTML, removing airline logos, as well as many of the columns.
3.1.2. Instructions
You must have at least one flight, car and/or hotel type sold on the Sabre point of
sale before using the Itinerary function.
If under the Itinerary Preference Setting you have not selected plain text as a
default for your output, you have the option to request this for your current
itinerary request.
Select <Clipboard> from the Application Side Bar, you will see the Clipboard
function menu, select <Itinerary> to be presented with the following window,
alternatively you can type <CB ITIN> into the Sabre emulator. You are now
presented with several options.

You can specify which segments you would like to see on the output, add free text
remarks or you can pull segment related remarks from the PNR and/or show the
fare and tax details If you would like to add free text to your itinerary output check
the Add Free Text box, you can specify which segments you would like to add free
text too or leave blank for all segments.
If you already have Segment Associated Remarks in the PNR and you would like
these remarks to show on your itinerary output, you can check the second box,
Add Remarks from PNR. You can specify which segment’s associated remarks you
would like to pull into your output.
If you have selected Add Free Text, you will be presented with a subsequent
window which will allow you to input the remarks per requested segment. This
information will not be added to the PNR.

If you select the Add Fare and Taxes checkbox, more options are displayed:
Specific PQ records need to be chosen to automatically determine the fare
amounts from your booking, although these may be overtyped.

If under the Itinerary Preference you have selected Price per Person, the “Select
all” button will be greyed out and you can only select one PQ record. The
fare/tax/total will show for one passenger regardless if there are multiple
passenger in the PNR.

If you have selected Total Price you are able to choose multiple PQ records and
the amounts will be combined giving you the fare/tax/total for all PQ records
selected.

If there are no PQ records stored in the booking, all fields may be manually
typed.
If you have specified a Mark-up or Service Fee amount in the Itinerary
Preferences these fields will be prepopulated with the amount, although these
fields may be overtyped.
By selecting the checkbox to add fare rules, a second window will be displayed
once <OK> is pressed.
This allows you to select the Fare Basis and City Pair from the drop-down list (for
the chosen PQ record from the previous popup). You are also able to change
the directionality of the City Pair selected, by clicking on the arrows. This is
specifically used to allow you to select reversed City Pair direction that is not
show in the drop down list, but is applicable to the fare calculation.
Note: If you are unsure which direction the city pair is applicable to, you can
check by using the Fare Calculation Description Display (WPDF) entry in Sabre.
For more information on the WPDF please review Format Finder reference
prifo400
By selecting <Get Rules>, Clipboard will search the fare rules for the given city
pair and fare basis and show the response in the right-hand window. You can
either select <Parse> which will “interpret” the rules into customer friendly
language where possible; alternatively, you can select predefined text from the
dropdown menu of for each rule category. All fields may be overtyped.
There is a free text area specifically for any notes the agent may wish to add.
These notes can be saved and will show on each output.

It is important to note that Sabre has no responsibility for any incorrect fares
advised, so rules should still be reviewed carefully.

Press <OK> and the application will take a few seconds to “interpret” all the
data and store the HTML output into the Windows clipboard ready for pasting
anywhere you like. Here is a sample of the output.
From this:

To this: (Based on options selected in preferences)

3.2. Schedules
3.2.1. Description
The Schedules feature allows for the creation of a HTML table of either daily or
weekly schedules for any city pair of your choice.
You have two options for the output display, send the schedule response to your
output canvas or display within the Sabre Red 360 frame.
3.2.2. Instructions
If under the general Schedule Preference Setting you have not selected plain text
as a default for your output, you have the option to request this for your current
schedule request. Similarly, if you have not selected Display Results as your
default you have the option to request this for your current schedule request.
Select <Clipboard> from the Application Side Bar, you are then presented with the
Clipboard function menu, select <Schedules> to create a table of a week’s
schedules for any city pair of your choice. Alternatively typing < CB SCHED > into
the Sabre emulator will launch the Schedule Window.
The output schedules table can include Direct flights and Codeshare flights
(duplicates of the operating carrier schedules but with a different flight number).
Optionally, you may sort the results by Departure Time, Airline, From or To
Airport.

Press <OK> once you have selected your options. The tool will find the preceding
Saturday from the date selected and work forwards from there, gathering the
flight information. In the bottom right hand corner of the Sabre Red 360, you will
see the Status Bar while the table is being formatted.

Open a new email in your preferred email application (Outlook, Lotus Notes etc.).
Then, either press Ctrl + V or right click in the email and select Paste. The
schedules will be shown as below.
Here is a sample of the output which includes the dates of operation for a specific
train or flight. Note that airline logos are not used with Schedules to save on
space.

3.2.3. Shopping
3.2.3.1. Air Shopping

3.2.4. Air Shopping
3.2.4.1. Description
The Air Shopping feature allows the ability to take any airline itinerary and give
alternate pricing and airline options. Using the Low fare search command
“WPNI” it builds the Sabre format according to your choice of qualifiers.

3.2.4.2.

Instructions

If under the general Shopping Preference Setting you have not selected plain
text as a default for your output, you have the option to request this for your
current shopping request.
Select <Clipboard> from the Application Side Bar, to launch the Clipboard
function menu. Under the Shopping section select <Air> from the drop-down
list, then click on <Shopping > to be presented with the following window.
Alternatively, you can type <CB SHOP‡AIR> into the Sabre emulator to retrieve
the Air Shopping window.

Based on your traveller’s preference you can include several qualifiers, from
preferred/non-preferred carriers, to Shop by Arrival time or alternative Airport
Searches. You can also specify the number of options you would like returned,
the default number is 9, but you can request up to 19.
The format to create this entry is shown at the bottom of the popup, for
information purpose only.
By selecting the “More Options” checkbox at the bottom right hand corner and
pressing the <OK> button you will presented with additional qualifier as shown
below.

You are now able to select any of these additional qualifiers including direct
flights only and private fares, you are also able to specify Corporate ID and
Account Codes.
Note: For full details on the Shopping optional qualifiers please see format
finder prifo009
Press <OK> once you have selected your qualifiers. While Clipboard searches for
your alternative air and fare option you will see the status bar in the right-hand
corner.

You will then be presented with a third popup window which will show all the
travel options that have been found within the selected parameters.

On this popup, you can use your mouse to select any of the options you want
presented in your output. Alternatively, you can use the “select all”, if all
options are required.
If you would like to add comments to the Shopping Options you have selected,
check the Free Text box and you will be presented with a free text Window to
add your comments. After selecting <OK> these comments will show at the
bottom of your selected option in the Results window and will show on the
output. These comments will not show in the PNR.

In the Air Shopping Results dialog box, for each option listed, there is a checkbox that can be checked to let the user add the fare rules of the selected option
in the output:

Clicking the check-box will show the "Shopping Rules" dialog box:

If you have not added a default Mark-up under the Shopping Functionality
Setting, on the right of the Results popup there is an area where the mark-up
amounts may be added to the final fare output (hidden). Or they may be left
blank if no mark-up is required.
The HTML output can include airline logos (if requested in the settings).
Here is an example of the output:

3.2.5. Hotel Shopping
3.2.5.1. Description
The Hotel Shopping feature allows the ability to shop for hotel option that can
be quickly selected and sent to travellers. You do not need to have a PNR
present in the Sabre Emulator.

3.2.5.2.

Instructions

If under the general Shopping Preference Setting you have not selected plain
text as a default for your output, you have the option to request this for your
current shopping request.
Select <Clipboard> from the Application Side Bar, you will see the Clipboard
function menu. Under the Shopping section, select <Hotel> from the dropdown
list, then click on <Shopping> to be presented with the below window.
Alternatively, you can type <CB SHOP‡HOT> into the Sabre emulator to retrieve
this window.

If you have a flight segment present in the emulator you can specify the
segment number the hotel will be related to. Clipboard will then read the City
and Check-in Date these two fields will be greyed out in the window. You can
either specify the check-out date or number of nights. Alternatively, you can
input this data in yourself. You now have the option of including qualifier to help
narrow down your Hotel Shopping search. If you would like the option you are
sending to your traveller to show in the PNR, check the Add Remarks in PNR box.

Once you have entered the desired fields select <OK>, while Clipboard searches
for your Hotel Options you will see the status bar in the right-hand corner.

You will then be presented with a second popup window which will show the
Hotel options available based on the selected parameters.
On this pop-up you can use your mouse to select any of the option you want to
present in your output; alternately you can use the <Select All>, if all options are
required. At the bottom of the window you will find the Amenities legend.

Here is an example of the output for Hotel Shopping Response.

3.2.6. Car Shopping
3.2.6.1. Description
The Car Shopping feature allows the ability to shop for car rental option. You do
not need to have a PNR present in the Sabre Emulator.
3.2.6.2.

Instructions

If under the general Shopping Preference Setting you have not selected plain
text as a default for your output, you have the option to request this for your
current shopping request.
Select <Clipboard> from the Application Side Bar, you will see the Clipboard
function menu. Under the Shopping section select <Car> from the dropdown
list, then click on <Shopping > to be presented with the following window.
Alternatively, you can type <CB SHOP‡CAR> into the Sabre emulator.

If you have a PNR present in the emulator you can enter the segment number
for the pick-up and drop-off points, Clipboard will read the Pick-up/Drop of city,
date and time and these input fields will be greying out. Alternatively, you can
input each field manually. You also have the option to input several qualifiers
like Car Type, CD and ID number to help you narrow down your search. If you
check the Add Remarks box this will add the chosen option into the remarks
field of the PNR.
Select <OK>; while Clipboard searches for your Car Options you will see the
search status bar in the right-hand corner.

You will then be presented with a second popup window which will show all the
car options that have been found within the selected parameters.

On this pop-up you can use your mouse to select any of the option you want to
present in your output; alternately you can <Select All>, if all options are
required.
Here is an example to the output:

3.2.7. Hotel Billback
3.2.7.1. Description
Hotel billback is a process where an agent books a hotel, then requests the
charges get billed back to the travel agency on completion of the traveller’s
stay.

3.2.7.2.

Instructions

To create a hotel billback fax you must have a Hotel booking (which can be
either HK or GK segment status) present in the Sabre Work Area.

Select <Clipboard> from the Application Side Bar, you will see the Clipboard
function menu. Select <Hotel Billback> to start the operation. The Clipboard tool
will “read” the Hotel booking details before presenting the following editor
window. If you have updated the Agency Information Settings, the Agency
Address field will be prepopulated.
Note: It is mandatory to include the Agency Logo, which can be added in
the Agency Information Settings.

By selecting the desired hotel from the drop-down menu, the data will populate
the “FAX TO” fields where possible. The “Free Format” field allows you to
include optional information which will show on the PDF output.
Output Language option allows you to change the language of the PDF letter
from the default language.
“FAX FROM” allows you to include the Organisation Name which is read from
the Company Address field within the Sabre Reservation.

The Payment Method gives you two options: A) Credit Card or B) Account, for
the charge back.
Once you have selected the “Billback Charges” select <OK> for the PDF to be
launched.

If you have select Credit Card for the charge back you are now able to input the
Credit Card Number, Expiry Date, CVV and Card Holders Name. Once you have
updated the Credit Card information you can print this and fax to the hotel.
Note: You will not be able to save the PDF

4. Clipboard Support
If you are unable to see the Clipboard Icon in the Application Side Bar Launcher, prior
to restarting Sabre Red 360 you can check under Help on the Sabre Red 360, Menu
Bar, then select History of Updates. This will show you if the App has been Installed or
Not Yet Activate.
If Not Yet Active you will need to restart.

Once restarted the status will change to Installed

After restarting Sabre Red 360, you may also look under Contact Us on the Menu bar
and Application Vendor Support to validate that the application has installed. This is
also where you will find the support details for Clipboard.

Supported Email Operating systems:
•

Office 2010

•

Outlook 2010

•

Thunderbirds

•

Lotus Notes

Clipboard does not support:

•

Outlook Express

•

Windows XP (and below)

•

Office 2003 (and below)

•

Gmail (it doesn't show vendors' logos)

•

Yahoo mail (it doesn't show vendors' logos)

•

Live Mail (it doesn't show vendors' logos)

Terminal Server deployments.

4.1. How to identify which version of the Clipboard application you are using:
An easy way to check which version is installed is from Contact Us > Application
Vendor Support, where you will see a list of the Apps installed on your Sabre
Red 360, select Clipboard and this will include the version number.

4.2. New Releases – actions required for Clipboard upgrades or patches.
If you do not have access to the Agency Admin Tool please contact your IT
department or Sabre Red Agency Administrator. To ensure the latest version is
activated please take the following actions:
Go to the Agency Admin Tool (see the screen shot below):

•
•

If this is the first time you have received the Clipboard application, please
ensure it is turned ON in the Agency Admin tool.
If you have a previous version of Clipboard, turn OFF the previous version and
turn ON the new version.

On Sabre Red 360, click Help and Check for Updates and ensure that they have
been downloaded.
Shut-down Sabre Red 360 and restart.
The change will not be visible until users restart the Sabre Red 360. Please be
aware the update may take 2-5 hours depending on system activity. However,
on occasions the change may be visible in a much shorter timeframe.

